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RMUG Meeting, Saturday morning
July 10, 2010 9-11:30 a.m.

All Mac users, new & old are invited
to attend the next RMUG general
meeting at:

Yaks Koffee Shop
3274 Bechelli Lane
Redding, CA

Coffee and various eats are
available during our “"Get
Acquainted” time, 9am to 10am.
There are classes for “Beginners”
and “Intermediate”
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President’s Letter

Is Google Chrome web browser really that good? Yes.

Over the last couple of weeks | have been starting Safari 5.0 and
Chrome 5.0 and | have seen a hundred incidents of websites that
balk at Safari for 1 to 3 minutes and 75% of the time Chrome will surf
right in and open the problem page. | have read where both Safari
and Chrome are built on Apple’s WebKit but it has been my
experience Chrome is quickly opening web pages that are so
frustrating in Safari that | would probably move on and skip the
website if not for Chrome.

Most of you know | am a diehard “stock Mac is good” kind of guy so
the previous paragraph was hard to write but at the same time it gives
the Apple Development Team something to set their sites on
equaling. And as a side note | have started testing Firefox 3.6 and it is
approximately equal to Safari.

This last month | found an amazing source of information that has
been staring me in the face for quite some time. It is inside of the
iTunes Store. Go across the top bar to where you see podcasts and
click on the small triangle just to the right and then scroll down to your
favorite category. Currently | am using and investigating Technology
and the 120 listed titles appear to be just the tip of the iceberg. As an
example click on any of the Photo Shop links and when the page
opens scroll down the page and there are 10 more titles in the
horizontal scroll bar. And if you want to do a search just type a name
in the Store Search on the top right corner of iTunes and you may or
may not get what you are looking for as the search includes the whole
store not just the free podcasts. The Podcast | like the best so far is
the instructional videos for Freeway, the web page tool | use to build
the RMUG website. Here are a few links | believe some of you may
enjoy:

id183094736

http://itunes.apple.com/us/podcast/microsoft-office-2008-for/
id299746832

0274564859
continued on page 3


http://itunes.apple.com/us/podcast/photoshop-cs5-online/id183094736
http://itunes.apple.com/us/podcast/photoshop-cs5-online/id183094736
http://itunes.apple.com/us/podcast/microsoft-office-2008-for/id299746832
http://itunes.apple.com/us/podcast/microsoft-office-2008-for/id299746832
http://itunes.apple.com/us/podcast/microsoft-office-2008-for/id299746832
http://itunes.apple.com/us/podcast/valley-forge-peco-podcasts/id274564859
http://itunes.apple.com/us/podcast/valley-forge-peco-podcasts/id274564859
http://itunes.apple.com/us/podcast/freeway-moments/id264836028
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Why RMUG? The Redding Macintosh Users’ Group was formed to
help members and new users obtain maximum enjoyment and
performance from their computers. This is accomplished through
group activities and our direct affiliation with Apple™.

Resources: RMUG resources include monthly mailings from
Apple™ and numerous outside vendors. We have a library of public
domain programs, games and shareware software. We have videos and
other computer-related guidebooks and information.

Meetings: RMUG meetings are held on the second Saturday of
each month from 9:00 to 11:30 am - contact any club officer for
meeting location. The meetings give members and visitors an
opportunity to share information, opinions, personal experiences and
techniques regarding Macintosh computer systems—hardware &
software.

Membership Information: we invite you, as a guest, to
attend our next monthly meeting. If you decide to join RMUG, your
membership fee includes your whole family. We need your help as
much as you need ours! Please participate!

Welcome To Our Meetings: call the President, Dale

Josephson at 241-8227 or contact other RMUG officers for help. Go to
http://rmug.org/membership.html for numbers.

Membership Dues: $24 / year. Includes newsletters, access to
shareware, monthly workshops, troubleshooting help. Payment of dues
can be made at the monthly meetings or send them to: Charlotte
Ruskowitz, 6538 Mossom Ln., Anderson CA 96007 . Please make check
payable to: Redding Macintosh Users’ Group.




Presiden’t Letter Cont’d

http://itunes.apple.com/us/podcast/freeway-
moments/http://i

On August 14th we are going to have our
Annual RMUG Picnic and it is being held at
Laurie Masterson’s home in South Redding.
We will have maps and directions available at
the July RMUG meeting. Laurie is a very long
time Mac user and friend to many of us so we
should all feel right at home. There is a pool
and plenty of green grass and shade so
please make plans to join us in the food and
fun. As in previous years this will be a potluck
with those with last names starting with Ato K
bring a salad and L to Z brings a desert. The
club will have hamburgers, hotdogs and
condiments including buns. | have heard there
will be chicken available also.

Dale Josephson
Dale Josephson Consulting
Apple Developer & Support
(530) 241-8227

mrdalej@mac.com

SECRETARY’S NOTES

MINUTES - RMUG MEETING, June 12,
2010

The June meeting was held at YAKS Koffee
Shop. Twenty-Two members and guests
attended.

While Dale met with the beginner’s group,
Michael answered questions from the
advanced group.

Summer changes:

Weekly Macintosh classes at the Anderson
Senior Center are winding down for the
summer. Michael Peters will have his last
beginner’s class on Monday, June 21 from
1:00 — 3:00 p.m.

Dale Josephson will continue the Advanced
class on Fridays, 1:00 — 3:00 p.m. through
July, or until he has no more than 2 people

attending. Then off ill September.

Michael’s Pixelmator class will be Monday,
June 21 at 10:00 at the Anderson Senior Center.
You bring your own computer.

Presentations.

Dale demoed WiFire. From his home in West
Redding, it had a range of up to 300 feet line of
sight and through trees. WiFire is a USB 2.0
plugin that works much like an Apple AirPort
Card. Thumbs up.

Safari 5 is out. Click ‘Reader’ to get rid of adds.

Purchase ‘Line2.com’, an App for $.99 from
iTunes App store for use with your iPod /iPad.
Will also work with your iPhone if you are in
range of a WiFi. Airport Extreme is a WiFi. Line2
is by TOKTUMI. Monthly charge is $14.95.

iPod Touch 8G does not have a microphone.
iPod Touch 32G ($299) has a built-in
microphone. $79 for a mike that plugs in on
bottom. Griffin has outstanding iPod
accessories.

New iPhone 4 has a glass back and better
signal.

Reminder: No meeting at YAKS in August.
Instead, picnic at Laurie’s home in Redding.
Maps/directions will be available at July
meeting. Miss the meeting? Call an officer for
directions. The picnic will be a barbecue. The
club will furnish hamburgers and hot dogs, and
Barbara Benefield is planning to bring some
precooked chicken filets. Club also furnishes
plates, utensils, condiments, etc. Everyone
please bring a dish to share. A-L/M —
Salads; M/N-Z — Desserts. Also, please bring
your own beverage and perhaps a chair.

Next Meeting at YAKS on July 10, 2010.
Michael Peters will demo a different AKVIS
software program. Dale Josephson will demo
iChat.

Jacquie Martin, Secretary


http://itunes.apple.com/us/podcast/freeway-moments/http://itunes.apple.com/us/podcast/freeway-moments/id264836028
http://itunes.apple.com/us/podcast/freeway-moments/http://itunes.apple.com/us/podcast/freeway-moments/id264836028
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Senior Moment
DIGITAL JUKEBOX

Do you want access to music and videos
directly from your computer? You've come to
the right place. Use this program to import
existing music from your CDs. You can listen
also browse the iTunes Music Store. There,
you'll find over 3 million songs, 35,000
podcasts and 16,000 audiobooks.

Download your favorite music videos and TV
shows. Listen to radio stations, free. There is
no messy streaming or advertising to worry
about.

Want more portability? Sync your favorite
tunes and videos to your iPod with Apple's
iTunes.

Barbara
Popcap Game Review

| checked out popcap.com after Michaels
demo on Saturday, and signed up for the
passport. Then | went on to try plants vs.
zombies. | was instantly addicted to this
simple silly game and | purchased it at an
immediate 10% discount. There seems to be
no where to tell them | am an rmug member
SO maybe you can gather up emails like this
one and let them know we support them with
our dollars.

Michael K.

Popcap Game Review #2

At the RMUG meeting | won the game from
POPCAP. | had a problem getting my free
copy but with Michael’s help and an Email
everything got fixed and | downloaded my
AMAZING CARIBBEAN ADVENTURE.

Then | received another Email from POPCAP
giving me another free coupon for the
inconvenience caused. So | now have 2 of their
games for free.

AMAZING CARIBBEAN ADVENTURE is very
addictive and fun to play. In factitis hard to
stop playing it. | shall have to allocate a special
time for playing otherwise | won’t get any of my
regular chores done.

| found the game made me a lot more
observant and really kept my mind working.
Great game. | intend buying more games from
this Company.

Doreen

APPLE DOMINANCE

5/26/10

NEW YORK (CNNMoney.com) -- Microsoft's
dominance as the tech industry's most valuable
player has ended.

On Wednesday, Apple's market capitalization
edged past its longtime rival's as investors made
official what consumers have long suggested:
Microsoft is no longer the industry's alpha dog.
Just last month, Microsoft's market cap
exceeded Apple's by about $25 billion, but now
Apple is in the lead by nearly $3 billion.

Microsoft's consumer products business is
struggling to compete as Apple's hot new items
like iPad and iPhone capture the attention of
customers.

Microsoft (MSFT, Fortune 500) fell 4% to close at
$25.01 on Wednesday, while Apple (AAPL,
continued on page 5
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Apple Dominance Cont’d
Fortune 500) lost 0.45%, closing at $244.11.

Shares of Microsoft have dipped more than
15% in the past couple weeks, while Apple's
stock is down just over 6%, despite recent
market volatility.

"What this really means is that Wall Street
has more confidence in Apple's growth
prospects than it does in Microsoft's growth
prospects," said Matt Rosoff, lead analyst at
Directions on Microsoft, an independent firm.

"Apple is showing high growth, with the
launch of its iPad and its new iPhone coming
out, and while Windows is a great competitor
versus the Mac, Microsoft just hasn't come
up with new areas of growth."

Microsoft's reputation as a market leader
took another hit Tuesday when the company
announced that it plans to shake up its
management structure.

Amid the shuffle, Robbie Bach, who was in
charge of years-long effort to turn Microsoft
into more of a threat to Apple by heading the
entertainment and devices group and
overseeing innovative consumer products
like Xbox and Zune, will retire from Microsoft
in the fall.

"This just means those efforts didn't work
out," said Roger Kay, president of analyst
firm Endpoint Technologies. "It's sort of like
Japanese samurai ethic, which says you
need to fall on your sword to maintain your
honor."

Tow the line or keep up with the Joneses?
Part of Microsoft's problem is that, instead of
finding its own audience, it has fallen into a
game of catch-up and is focusing too much
energy on finding products to directly rival
Apple's, said Kay.

"l don't know if they have to compete," he
said. "What seems to be working for
Microsoft is its serious applications for
businesses, education institutions and other

enterprises, and if they stay focused on their
commercial business that gives them a lot."

While Microsoft's first quarter earnings were
boosted by the success of its new operating
system, Windows 7, Apple's record profit and
revenue in the first quarter was driven by iPhone
sales.

And many of Microsoft's efforts to branch out have
been met with little success. For example, the
company's Zune music player, meant to rival the
iPod, has failed to create the same buzz as
Apple's device, with sales dropping significantly in
2009.

Microsoft even looked into creating a tablet
computer that would have competed directly with
the iPad, which Apple introduced at the beginning
of April, selling more than 1 million in the first 28
days of release. But Microsoft CEO Steve Ballmer
ended up pulling the plug on the project before the
tablet ever made it to market.

"Zune hasn't gone anywhere, their tablet is dead,
their phones are having trouble establishing a
market position -- but consumers still use Office
and Windows," said Kay.

Other experts say that Microsoft shouldn't stop at
its core business, and that it simply needs to
innovate more -- and faster -- in order to stay
competitive.

"They have to continue to try to find other
businesses, otherwise growth is always going to
be bound by the PC market," said Rosoff.

Until Microsoft develops a clear direction and finds
new ways to innovate, Apple will continue to push
ahead, he said.

"Wall Street believes in Apple because Apple
continues to put out new products that capture the
imaginations of the press and tech pundits," said
Rosoff. "Microsoft just hasn't been able to come
up with a new multi billion dollar business like
Apple."

submitted by Barbara

continued on page 6
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DRYER TIP

Always have a bathtowel in your clothes
dryer--always. A towel in the dryer cuts down
dryer time. It absorbs extra moisture out of
the clothes and the time it cuts down in
drying time can be 1/3-1/2. Try it!

submitted by Barbara

WI-FIRE

At last months RMUG meeting |
demonstrated the Wi-Fire a long-range
WiFi adapter for any Mac or PC with a USB
2.0 port available. Wi-Fire is USB bus
powered SO N0 messy power cables.

To conduct my test | used my home
network that consists of two Apple Airport
Extremes connected together in WDS
mode. Both Airports are Gigabit b-g-n
models about two years old. Both Airports
are set to bridge mode as my DSL modem
handles all the IP addressing.

My test computer is an 18 month old
2.4GHz MacBook with built in Airport
Extreme running Snow Leopard 10.6.3.

Inside my Network Control Panel | set up a
location that only contained Airport and Wi-
Fire. | conducted all tests 3 or more times
to insure my data was accurate..

Starting in my office that is about 60 or 70
feet from each Airport Base Station, | was
able to connect with 4 signal strength bars
to both base stations using my built in
Airport card. Next | turned off the Airport
card and connected with the Wi-Fire and its
signal strength was 38% although it surfed
the Internet just fine.

Next | moved the testing to the end of my
driveway that would be about 110 feet from

each base station and | had slightly diminished
signal strength readings from internal Airport card
(3 bars) and Wi-Fire (28%).

So now | am getting serious and moved across
the street and leaned on my neighbors front fence
and my strength readings dropped to 2 bars for
Airport and 22% for Wi-Fire but | could surf and
email just fine.

Well the neighbor was not home so | did not go
into her yard, instead | headed east to the drive-
way of the 2nd house and now | am finally seeing
strength issues. One of my Base Stations has 1
bar and the one mounted 50 feet closer to me
and 10 feet higher has 2 bars and the Wi-Fi said
8% & 18%. My neighborhood is hilly and about 10
feet further | was going down a hill and had lost
direct sight to my home and both Base Stations
disappeared from Airport and Wi-Fi. To keep the
test fair | did not use the USB cable on the Wi-
Fire to raise the Wi-Fire above my head.

| decided to see how well my wireless worked
through very dense wooded terrain so | walked
west back past my place and went to the other
neighbor’s house across the street that is one
home west from where | started my testing. In his
driveway | was getting 2 bars from the Airport and
18% from the Wi-Fire. Email and surfing all
worked well.

Then | walked west about 30 feet more and the
Wi-Fire was able to connect and email while the
Airport could see the two base stations but | could
not get a stable connection. 6 to 10 feet more
and the Wi-Fire could not surf. It appears | got
approximately 300 feet in mostly open terrain and
200 feet through the dense oak & pine forest at
the front of my homin conclusion | will say if you
are having difficulties going the last 30 feet or
through several walls the Wi-Fire is an absolutely
great wireless card adapter. | can see how having
the Wi-Fire on a 3 ft. USB cable would let you
extend your range easily by placing the device in
a window or just higher to avoid radio wave
dampening clutter us humans stack all around
ourselves.

continued on page 7
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Wi-Fire Cont’d

| did notice my laptop-cooling fan was running
almost continually when the Wi-Fire was
plugged in and my guess is it was such a
drain on my battery that the laptop felt the
need for additional cooling.

Dale Josephson
Dale Josephson Consulting
Apple Developer & Support
(530) 241-8227

mrdalej@mac.com

DATABASES TRACK YOUR
EVERY MOVE & MORE

Ever wonder just how much information
about you is contained in databases and on
the Internet? Here’s a hint. It’s much more
than you think.

If your telephone number is published, a
simple Google search can turn up your
home address, phone number, and a map to
your front door. Everyone knows that. But
there are other databases and sites that
contain intimate details of your life.
Specialty reports let potential insurers check
your prescription history. Retailers can view
your purchase returns history. And your
employment and rental history are also
online.

This information may be incorrect. It can
haunt you when you apply for a job, credit or
health insurance. So, it’s a good idea to do a
background check on yourself from time to
time.

The Fair Credit Reporting Act lets you
request free credit reports once a year. You
can also request a report if you’ve been
denied credit based on information it
contains. And, you can request that any
errors be corrected.

Credit Reports

Credit reports are widely used to verify your
credit-worthiness. Experian, Equifax and

TransUnion are the three main reporting
agencies. You can request your free report by
visiting AnnualCreditReport.com. You can
request reports from all three agencies.
Personal Information Reports

Personal Information Reports include
information on your employment and tenant
history. They also contain information on liens
and judgments, voter registration and more. This
information is used for background screening.
Start by requesting a report from LexisNexis.
Then, request your background screening report
from Acxiom. You can also request information
from Acxiom’s directory and fraud detection
service; however, there is a $5 charge for that.
You should also request a Full File Disclosure
from ChoicePoint, a LexisNexis company. The
information will differ from your LexisNexis
report.

Insurance Reports

Your ChoicePoint Full File Disclosure will include
home and auto insurance claims. But you’ll also
want to order a report from Insurance Services
Office.

Have you applied for individual health or life
insurance in the past seven years? Then, you
may have a file at the Medical Information
Bureau. It is designed to protect insurers from
fraudulent or incomplete applications.

Your file may include information on medical
conditions and tests. It could also include driving
history and dangerous hobbies or professions.
You can request your consumer file from MIB.
However, it may not have one on you.

Your prescription drug information may also be
available to insurance companies. IntelliScript
and MedPoint compile information on drugs,
including refills and dosages. It can go back five
years.

Checking Reports
Banks often use ChexSystems to vet account
applications. Your report may reflect accounts
that have been mishandled. For example, it
shows if you have had excessive overdrafts.
Retailers use TeleCheck for check verification. It
gathers information on returned checks and
continued on page 8
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Databases Cont'd

check fraud.

Employment history

The Work Number collects employment and
income information. The data comes from
employers. Abso also gathers employment-
related information.

These companies may not have information on
you. Still, you’ll want to request copies of your
files from both companies.

Tenant history and utilities reports

A number of companies gather tenant
information. The information can include
evictions and disputes with landlords.

Your tenant history may be available from one
or more databases. Check with First
Advantage SafeRent, RentBureau and Tenant
Data Services.

The National Consumer Telecom and Ultilities
Exchange provides information to utility
companies. It stores information on defaulted
and fraudulent accounts.

Other reports

The Social Security Administration sends
yearly Social Security statements. Your
statement shows your Social Security earnings
history. It also includes estimated benefit
payments. You can request a copy of your
report at any time.

The Retail Equation is designed to prevent
fraudulent and abusive returns. Information
provided may prevent you from returning an
item to a store. In that case, request a copy of
your return activity report.

Teletrack collects subprime credit information.
It is used by payday loan companies.
CentralCredit is a credit bureau used by the
gaming industry. Casinos use it when
extending credit to guests.

The process for requesting a specialty report
varies from database to database. You may
need to call the company or mail a form. Be
prepared to disclose your Social Security

number and current address. You may also
need to submit copies of documents to prove
your identity.

CREATE EFFECTS IN
IMOVIE STILLS

by Rob Griffiths, Macworld.com

Although | typically use Final Cut Express for
my video projects, | recently had a really short
project to do for the family, so | thought I'd give
iMovie another trial. Although | did get the
project done, | found myself fighting iMovie’s
interface at nearly every step (I am not a fan of
the “toss all the clips in a bin and scrub as you
mouseover” setup).

One thing in particular that | wanted to do was
use the Ken Burns’ effect (animating still
images through crop, zoom, and move actions)
with a pause on the “before” and “after”
images. By default, when you apply Ken Burns’
effects in iMovie, they start as soon as the still
image is displayed, and then are auto-timed to
end when the still image vanishes. Depending
on the type of pictures you're showing, this can
be disorienting.

What | wanted to do was have the image
appear fixed for a certain time period, then
show the Ken Burns effect, and then hold on
the final image for a bit before fading out. This
is something that was relatively trivial in
iMovie HD, but as | discovered, it’s far from
trivial in iMovie. (It'd be trivial if iMovie let you
create a still from a Ken Burns-modified image
in iMovie, but you can only create stills from
movies, not other stills.)

After fighting it for a few hours, | gave up and
asked the Twitterverse for assistance. Twitter
user 2mutch came through with the solution,
although it was complex enough that it
required an e-mail exchange— 140 characters
just wasn’t enough room for all the details.

If you want to get this pause-move-pause
effect in iMovie, here’s how to do it—the steps
may seem confusing in text, so I've also

continued on page 9
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Create Effects Cont'd

included a little demo movie that shows
exactly what you need to do.

(Sorry, but there was no demo movie at-
tached to this article.)

Add the still you want to modify to your
project, and set up the Ken Burns
effects as you’d like them to be.

Duplicate the still twice (Edit -> Copy,
then Edit -> Paste twice), so you have a
total of three copies of your still.

In the first image in the series, which
will be the “before” still, edit the Ken
Burns effect so that the End effect’s
size and position is identical to that of
the Start effect.

In the last image in the series, which
will be the “after” image, click the small
two-headed circular arrow to flip the
Start and End effects.

Set the End effect’s size and location to
be equal to that of the Start effect.

After you do the above, you can also alter the
duration of the before and/or after images to
suit your movie’s timing needs. If the above
instructions seem confusing, try watching this
brief movie (click the red badged area of the
movie to watch).

If iMovie would simply support the creation of
a new still from a still that’s had the Ken
Burns’ effect applied, this entire process could
be greatly simplified—just apply Ken Burns,
then use the first and last frames of the
animation to create new stills. Even better
would be total control over Ken Burns,
allowing the user to specify the start time,
duration, and end time for the effect. Who
knows; maybe we’ll see this in iMovie ‘107 If
you know of simpler ways to accomplish the
same thing in iMovie, feel free to share in the
comments.

submitted by Barbara

INFORMATION 411

The old 411 — 800 # was not user friendly. This
one is! | have used it twice and it works great!
Here is something you will want to have and
use! | still remember when the telephone
company charged me $0.00 and now they
charge $1.00 to $1.50 to get a phone number
from information.

My compliments to Google!
Just leave it up to Google to come up with
something like this!!!

Here's a number worth putting in your cell
phone, or your home phone speed dial: 1-800-
goog411. (1-800-466-4411). This is an
awesome service from Google, and it's free --
great when you are driving on the road with no
pen, pencil or paper handy.

Don't waste your money on information calls and
don't waste your time manually dialing the
number | am driving along in my car and | need
to call the golf course and | don't know the
number. | hit the speed dial for information that |
have programmed.

The voice at the other end says, "City & State." |
say," Garland, Texas ." He says, "Business,
Name or Type of Service." | say, Firewheel Golf
Course." He says, "Connecting" and Firewheel
answers the phone. How great is that? This is
nationwide and it is absolutely free! You can
even say “text” and they will sent you the
address info.

Click on the link below and watch the short clip
for a quick demonstration.
http://www.googlecom/goog411

submitted by Jacquie

LINE 2

Line2 from TOKTUMI is a 99-cent application |
purchased from the iTunes APP store. There is
a 30 days free trial and using a Credit Card
$14.95 per month after that. Free calling in the
USA and overseas calls start at 2 cents per
continued on page 10
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Line 2 Cont’d

minute. How it works is you connect your
iPhone to WiFi, which most of us do everyday
anyway and all calls are routed across the
Internet instead of AT&T’s cell network. Since |
live 300 feet west of Redding and AT&T
wireless does not reach here | have been
paying $75 per month for four years and only
getting service 3% of the time. Now after using
Line2 | have decided | can live without AT&T
on the iPhone and will switch to Line2
exclusively on July 19th. | just went into the
AT&T Store and arranged to turn my iPhone
off at the end of the next billing cycle. | will see
if | can live without cell service, which should
be easy since AT&T only worked when | drove
to town anyway.

Line2 is compatible with iPhone, iPod Touch
(2nd & 3rd Generation) and iPad with iOS
3.1.2 or newer. If you are considering this for
an iPod Touch it requires the models with a
microphone or you need and external
microphone. May | suggest just using it on
iPod Touch with the built in microphone. ie the
$300 model and not the $200 one.

There are features such as Voicemail and
Conference Calling at no extra charge. During
business hours there is free online web-chat
support that is most excellent.

Here is a link to the main website: http://
www.line2.com/

And this is the iPod & iPad link: http://
www.line2.com/ipod ipad.aspx

David Pogue of the New York Times said, “It
can save you money. It can make calls where
AT&T’s signal is weak like indoors. It can turn
an iPod Touch into a full-blown cell phone. And
it can ruin the sleep of cell phone executives
everywhere”.

Dale Josephson
Dale Josephson Consulting
Apple Developer & Support
(530) 241-8227

mrdalej@mac.com
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LITTLE-KNOWN
NEATO IPHOTO TIPS

I've recently spent a few hours cleaning up my
iPhoto library. This included adding proper
image titles, keywords, updating Places and
Faces info, deleting duplicates (and redundant
photos in general), as well as deleting albums,
smart folders, and slideshows that have outlived
their usefulness. Here are a few tricks |
discovered that aren’t documented by Apple,
and apparently little-known on the web.

Did you know know you can compare an edited
photo to the unedited original? This only works
in iPhoto’s Edit mode. In Edit mode, simply hold
down the Shift key and you’ll see the photo in all
its pure, unedited glory.

Also in Edit mode, it’s possible to quickly zoom
in on a particular area of a photo. Simply hover
your mouse pointer over the area of interest,
and then press the 1 key to zoom to 100 percent
in, or press the 2 key for a 200% view. Jump
back to fit to view by pressing the 0 key.

Want to hide certain photos in your iPhoto
library, but don’t want to actually delete them?
Simply right-click (or Control-click) on the secret
photos and select “Hide Photo” at the bottom of
the list. If you want to see your hidden photos,
select View > Hidden Files in the iPhoto menu
bar.

| like Faces (though it’s not always amazingly
accurate) in iPhoto ’09. Did you know you can
change a person’s Key Photo in Faces? This is
the photo that shows on the Faces corkboard.
To do this, open a photo of the person in Faces.
Right-click on the image you want to be the key
photo and choose “Make Key Photo.”

You can also scroll your mouse over the Key
Photo in Face’s corkboard view, and while the
photos are flipping through, click the space bar
on the photo of your choice. That will be the
person’s new Key Photo.

Here are some more tips about Faces, from
Macworld magazine.

continued on page 11
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Neato iPhoto Tips Cont’d.

| also enjoy Places, iPhoto '09’s geotagging
feature. It’s fun to see my photos on a map.
iPhone photos are automatically geotagged,
but my other cameras lack a built-in
geotagging tool. It’s easy to manually add this
information to a photo, but it’s a chore to do
this for a big batch of photos.

However, | discovered that it is possible to
copy Places information from photo to photo.
Simply select a photo that has been tagged
with the correct information, right-click (or
control-click) on it and choose “Copy” from the
contextual menu. Now select your batch of
untagged photos, right-click (or control click)
on them, and choose “Paste Location.” Now
they all share the same location information.
When you delete a photo from your iPhoto
library, it goes into iPhoto’s trash. This gives
you a margin for error if you accidentally
delete a photo. Over time, iPhoto’s trash can
fill up with hundreds or even thousands of
photos, stealing gigabytes of space from your
hard drive. To see the contents of iPhoto’s
trash, click on the trash can icon in the left
panel of the iPhoto interface. In iPhoto 09, it’s
under the “Recent” header. To empty the
trash, click on iPhoto > Empty iPhoto Trash in
iPhoto’s menu bar at the top of the screen.

By Ed Shepard-Kibbles & Bytes
@smalldog.com

- > e UtJaly el N T

—— 1 cowbort of our own
ROt but T Bloady

(oo ter Cintts

11

QUICKLY SELECT
AUDIO INPUTS

If you use different audio input devices with
your Mac, (such as the Blue Microphones
Snowball) you’ve probably had to go to
System Preferences to change your selected
input device. If you’re using Mac OS 10.6
Snow Leopard, however, all you have to do
is hold down the Option key as you click on
the volume control in the menu bar at the top
of your Mac’s screen. If you have audio input
devices such as microphones, USB input
boxes, etc, these will show up in the drop-
down list.

Time to get a microphone and kick off your
karaoke career!

L= & Frigasp

v Headphones

v Internal microphone
Line In

Sound Preferences...

By Ed Shepard-Kibbles & Bytes
@smalldog.com

ORGANIZING YOUR
MUSIC IN ITUNES

Learn how to view your music collection in
different ways in iTunes on the Mac.
(MacMost Now #403) You can sort in
various ways, show album artwork, and
search. You can also create your own
playlists and organize them any way you
want.

Link: http://macmost.com/organizing-your-
music-in-itunes.html

Posted by Gary Rosenzweig on 5/26/10. You
can follow Gary on Twitter.
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Policies

This newsletter is published monthly
for the Redding Macintosh Users’
Group and is distributed to all club
members.

No other individual, group or
business may use any portion of
this newsletter without prior written
permission.

RMUG News welcomes articles
and questions relating to Macintosh
or Macintosh compatible computers.
Articles should be pasted into the
body of an eMail, or links to articles
submitted. It is important that full
credit be given to the author.

If you have a change of address
or other questions, please notify the
newsletter editor or other RMUG
officer as soon as possible.

Deadline for submissions is
the 25th of each month. E-mail or
deliver all material to:

Barbara Benefield
E- mail submissions to:
bbenefie @clearwire.net

OR
rmug@rmug.org

REMINDER:

Don’t forget, there will be no
RMUG meeting at YAKS in
August. Instead,we will have
our annual RMUG picnic. All
members are invited. Dale
will let everyone know
where and what time at the
July meeting.

Ad Rates

RMUG members are invited
to place “Wanted”, “For Sale”
& “Trade” ads in the
newsletter at no charge.
Business cards or
commercial accounts are
welcome at the rates listed
below. One of the best
reasons for belonging to a
user’s group is to let other
people know about your
activities, as well as learning
what other people are doing
with their computers and
software. Please give your
business cards or ads to the
newsletter editor.

AD Rates

$4-business card
Sé6-quarter page
$9-half page
$15-full page

Advertisements in the
RMUG newsletter will not
influence reviews or critiques
of hardware, software
companies or stories.

RMUG does not endorse
any specific dealer or
product, but we do encourage
the distribution of information
which may assist club
members in identifying best
buys and services.
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Editorial

June has been a sad month
for many RMUG members.
Michael lost his mother, Mary,
her father, and all of us have
lost a wonderful friend,
Charlotte Ruskowitz, who
has been our RMUG
treasurer for several years.
No one truly comprehends
the loss that you feel when
you've lost someone you
love. To Michael, Mary, and
to Charlotte's family, please
know that our warm thoughts
are reaching out in hopes
that you will know the
strength and comfort we wish
for you.

With Sympathy and Heartfelt
Condolences from all of us at
RMUG.

I'd like to share this poem.
Barbara

The Poem of Life

Life is but a stopping place,
A pause in what's to be,

A resting place along the
road,

To sweet eternity.

We all have different
journeys,

Different paths along the way,
We all were meant to learn
some things,

But never meant to stay...
Our destination is a place,
Far greater than we know.
For some the journey's
quicker,

For some the journey's slow.
And when the journey finally
ends,

We'll claim a great reward,
And find an everlasting
peace,

Together with the Lord.
--author unknown



Copyright 2002 by Randy Glasbergen.
www.glasbergen.com

“My doctor told me to start my exercise program
very gradually. Today I drove past a store
that sells sweat pants.”

ROTATE USER IMAGES
IN MANY OS X APPS

There are a few spots in OS X applications
where you have the ability to choose a photo
to use as a representation of you—Address
Book and iChat are two that come to mind.
In Address Book, click on your entry, click on
Edit, then double-click on the picture box
next to your name.

This brings up the picture selection window,
where you can take a picture with a
connected camera, insert an image from a
file, or paste an image from the clipboard.
While these features may be well known,
this one may not be: you can also rotate any
image, once it appears in this box.

Twist your image

Ll

ot
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To do so, just hold down the Option key and
then click-and-drag with your mouse or
trackpad. As you drag with the Option key held
down, you’ll see the image rotate, along with
an overlaid clock face of sorts (see picture at
left) to help you align the rotated image.

Posted by Rob Griffiths macworld.com

Macintosh Maintenance

On Site Service
25 Years Macintosh Experience

Dale Josephson Consulting
(530) 241-8227

Servicing RAM, Hard Drives, DVD Drives
Batteries
Software Installation and Upgrades
Mac OS-X Installation and Upgrades
Networking, AirPort, Time Capsule
Routers
Shared Hard Drives, Shared Printers
Screen Sharing, Apple TV
File Sharing AFP, FTP or Windows SMB
Timbuktu Cross Platform Computer
Sharing
Network Design. Upgrade or
Troubleshoot
Backup Design and Implementation

Macintosh - PC Integration
(S30) 241-8227 mrdalej@mac.com

Here's a tip as you get older:
Never wear a hearing arg,

because if you do,
people expect you
1o listen fo them.




CHARLOTTE RUSKOWITZ

Though our hearts are filled with much sadness my message is not one of despair, but
one of hope, love, and life. All who had the great fortune of knowing Charlotte Ruskowitz
will attest to her never-ending supply of understanding, humor and just good old
friendship. Charlotte loved life and serving others just because she could. She had a
quiet laugh and more importantly she loved to make others laugh or enjoy a funny
parable usually with a lesson on how to lighten up and enjoy life. Her jobs were never
ending from homemaker & wife to computer tech and parking lot ticket taker. She always
amazed me with how easy she seemed to balance everything with such ease and grace.
She was the type of person who used each and every minute of life to the fullest and
enjoyed being included in events whether it was among friends, co-workers or family. She
made new friends everywhere she traveled and it was not just humans she counted as
friends, as hound dogs from California, Nevada and Mexico were thankful she included
them in her journeys. As we mourn the loss of such a truly great friend, we should not
lose sight of these ideals Charlotte found so important. | am certain she would want us to
continue living our lives in the same caring and giving manner she demonstrated on a
daily basis. She would want us to celebrate her life rather than mourn her death. | for one
will miss her the rest of my days but also remember her life lessons and consider myself
wealthier for knowing she counted me as a friend and confidant.

Dale Josephson
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